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@ Legal notice

Copyright and trademark information relating to this product release.

Copyright © 2000-2022 SDL as part of the RWS Holdings Plc group of companies ("RWS
Group").

SDL means SDL Limited and its subsidiaries and affiliates. All intellectual property rights
contained herein are the sole and exclusive rights of SDL. All references to SDL shall mean
SDL Limited and its subsidiaries and affiliates details of which can be obtained upon written
request.

All rights reserved. Unless explicitly stated otherwise, all intellectual property rights including
those in copyright in the content of this website and documentation are owned by or
controlled for these purposes by SDL. Except as otherwise expressly permitted hereunder or
in accordance with copyright legislation, the content of this site, and/or the documentation
may not be copied, reproduced, republished, downloaded, posted, broadcast or transmitted
in any way without the express written permission of SDL.

MultiTerm is a registered trademark of SDL. All other trademarks are the property of their
respective owners. The names of other companies and products mentioned herein may be
the trademarks of their respective owners. Unless stated to the contrary, no association with
any other company or product is intended or should be inferred.

This product may include open source or similar third-party software, details of which can
be found by clicking the following link: “Acknowledgments ” on page 19 ..

Although RWS Group takes all reasonable measures to provide accurate and comprehensive
information about the product, this information is provided as-is and all warranties,
conditions or other terms concerning the documentation whether express or implied by
statute, common law or otherwise (including those relating to satisfactory quality and fitness
for purposes) are excluded to the extent permitted by law.

To the maximum extent permitted by law, RWS Group shall not be liable in contract, tort
(including negligence or breach of statutory duty) or otherwise for any loss, injury, claim
liability or damage of any kind or arising out of, or in connection with, the use or performance
of the Software Documentation even if such losses and/or damages were foreseen,
foreseeable or known, for: (a) loss of, damage to or corruption of data, (b) economic loss, (c)
loss of actual or anticipated profits, (d) loss of business revenue, (e) loss of anticipated
savings, (f) loss of business, (g) loss of opportunity, (h) loss of goodwill, or (i) any indirect,
special, incidental or consequential loss or damage howsoever caused.

All Third Party Software is licensed "as is." Licensor makes no warranties, express, implied,
statutory or otherwise with respect to the Third Party Software, and expressly disclaims all
implied warranties of non-infringement, merchantability and fitness for a particular purpose.
In no event will Licensor be liable for any damages, including loss of data, lost profits,
cost of cover or other special, incidental, consequential, direct, actual, general or
indirect damages arising from the use of the Third Party Software or accompanying
materials, however caused and on any theory of liability. This limitation will apply even
if Licensor has been advised of the possibility of such damage. The parties acknowledge
that this is a reasonable allocation of risk.

Information in this documentation, including any URL and other Internet website references,
is subject to change without notice. Without limiting the rights under copyright, no part of
this may be reproduced, stored in or introduced into a retrieval system, or transmitted in any
form or by any means (electronic, mechanical, photocopying, recording, or otherwise), or
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for any purpose, without the express written permission of RWS Group.
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@ About MultiTerm

About this guide

Welcome to the MultiTerm 2022 Installation Guide. This guide provides instructions for
installing and configuring MultiTerm 2022.

Intended audience

This guide contains information for whoever is responsible for installing and maintaining
MultiTerm (usually the MultiTerm administrator).

You are assumed to be familiar with standard Windows administration practices, such as
managing a Windows user account.

Related documentation

® MultiTerm Extract Tools Guide - A user guide for the terminology extraction tool -
MultiTerm Extract.

® Trados GroupShare 2020 Installation Guide - for those installing MultiTerm Extractin a
multi-user environment.

Accessing RWS documentation

You can check the help for all Translation Productivity products on the Documentation
Center.

About MultiTerm

Local and remote termbases

MultiTerm Desktop is a scalable solution that can be used in single-user or multi-user setups.
In a single-user setup, termbases are stored on the local computer. In a multi-user setup,
termbases are stored on a remote database server and accessed over the network.

Data storage

uses Microsoft Jet to store termbase data locally and Microsoft SQL Server (or SQL Server
Express) to store termbase data remotely.
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MultiTerm XML data format

MultiTerm termbase data is stored in an XML format, MultiTerm XML (MTF.XML). Other
termbase elements, such as the termbase definition and objects are also XML compliant.
The use of XML enables quick and easy exchange of data between users.

Language support

MultiTerm Desktop is Unicode-compliant and therefore supports a wide range of languages,
including bi-directional and double-byte character set languages. For example, termbase
fields can include a mixture of languages.

Note that to use non-Western languages, the relevant language support must be installed
on your computer.

Note:

¢ If you want compatibility across different language, enter the names of termbase
definitions and termbase objects in ASCIL.

MultiTerm Interface with Trados Studio

Trados Studio includes its own MultiTerm interface, so you can use MultiTerm termbases
from Trados Studio without installing MultiTerm Desktop.

Editions of MultiTerm

MultiTerm is shipped in four editions:

® MultiTerm Desktop ( MultiTerm, MultiTerm Convert, MultiTerm Widget)
® MultiTerm Widget
® MultiTerm Server

MultiTerm Desktop

MultiTerm Desktop is the MultiTerm edition that is installed on the desktop. It can use local
termbases and can also use remote termbases that are managed by MultiTerm Server.

MultiTerm Desktop includes MultiTerm Convert and MultiTerm Widget.

This guide describes the installation of MultiTerm Desktop.
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MultiTerm Widget

MultiTerm Widget is a simple application that captures text from your screen and finds
definitions in MultiTerm termbases, or by using Internet search engines.

MultiTerm Server

MultiTerm Server is the server component for corporate and enterprise customers as well
as language service providers (LSPs).

Termbases and associated data are usually stored in a Microsoft SQL Server, but you can use
Microsoft SQL Server Express.

MultiTerm Desktop components

MultiTerm Desktop

You can use MultiTerm to access termbase data stored on the local computer, and also as a
client to access termbases managed by MultiTerm Server.

Access to termbases stored on MultiTerm Server can be restricted by the MultiTerm Server
administrator.

MultiTerm Desktop also includes the following components:
® “MultiTerm Widget” on page 4
® “MultiTerm Convert” on page 5

MultiTerm Extract is now a standalone product that you can download from the RWS
AppStore .

MultiTerm Widget

MultiTerm Widget can be installed as a component of MultiTerm. It can also be installed on
its own.

MultiTerm Widget captures text from your screen and finds definitions in MultiTerm
termbases or by using Internet search engines.
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MultiTerm Convert

MultiTerm Convert is a stand-alone tool that converts terminology data to MultiTerm XML
format. It can convert data that is in the following formats:

Trados MultiTerm 5 .mtw
MultiTerm Desktop .tdb
MultiTerm Online .mdb
OLIF (Open Lexicon Interchange | .xml
Format)
Microsoft Excel .x1ls

.xlsx
Spreadsheet and Database .txt
Exchange

.Csv
Termbase Exchange (Termbase .tbx
eXchange Format)

.xml

You can also purchase an extra MultiTerm component separately.
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@ Installing MultiTerm Desktop

System Requirements

Hardware

As a minimum requirement, we recommend an Intel or compatible CPU-based computer
with 2 GB RAM and a screen resolution of 1024x768. For optimum performance, we
recommend 4 GB RAM and a recent Intel or compatible CPU.

Supported Operating Systems (OS)

® MultiTerm 2022 runs on the latest build of Windows 11, Windows 10 and the latest
updated version of Windows 8.1 and the latest service-packed version of Windows 7.
MultiTerm 2022 also supports Windows Server 2016, Windows Server 2012 R2 and
Windows Server 2008 R2.

® Limited support for Windows 7. Microsoft has stopped support for Windows 7. As a
result, we are no longer testing MultiTerm on Windows 7. However, MultiTerm continues
to work on Windows 7 as we have not made any changes that could affect the MultiTerm
functionality on this operating system.

® MultiTerm 2022 does not support earlier operating systems such as Windows 8, Windows
Vista, Windows XP and Windows 2003 Server.

Installing MultiTerm Desktop

Before you start

If you intend to use termbases that have been created in previous versions of MultiTerm,
review “Upgrading from Previous MultiTerm Installations ” on page 13.

Ensure that you have administrator rights.

Third-party software

MultiTerm needs Microsoft Internet Explorer and the following third party applications. It
will install them if they are not already installed:

® Microsoft .NET Framework version 4.8. In some cases, installing this requires a reboot.
This is usually installed by the bootstrapper that runs prior to the MultiTerm client
installer. It is also available from the Microsoft website.

® Microsoft Visual C++ 2008 Redistributable SP1. This is usually installed by the MultiTerm
client installer. When running the MultiTerm client installer, it is unpacked to
%ProgramData%\Package Cache\Trados\Dependencies\2008 SP1 vcredist x86.exe.
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This is also available for download from: http://www.microsoft.com/technet/security/
bulletins/ms11-025.mspx. If a previous version of this C++ runtime is installed, Windows
update will install the new version automatically.

® Microsoft Visual C++ 2013 Redistributable. This is usually installed by the MultiTerm
client installer. When running the MultiTerm client installer, it is unpacked to
%ProgramData%\Package Cache\Trados\Dependencies\2013 vcredist x86.exe.
This is also available for download here . If a previous version of this C++ runtime is
installed, Windows Update will install the new version automatically.

Installation locations

The installation working files are extracted to the folder: $ALLUSERSPROFILE%\Package
Cache\Trados\MultiTermDesktop202 2

By default, the installer installs MultiTerm under:
® For32-bitWindows - $programfiles%\ Trados\ MultiTerm\ MultiTerml7

® For64-bitWindows - sprogramfiles (x86) %\ Trados\ MultiTerm\ MultiTerml?

The Program Files folder on your computer may have a different name if you are using a
non-English operating system.

MultiTerm 2022 does not uninstall any previous versions of MultiTerm.

Installation log files

The installer logs significant actions to a log file.

® The log file for Windows 2003 is in: $ALLUSERSPROFILE%\Application Data\Trados
\Chainer\Logs.

® Thelog file for Windows Vista and later is in: $ALLUSERSPROFILE%\ Trados\ Chainer\ Logs.

Note: By default, Windows sets the %ALLUSERSPROFILE% folder to be hidden, so you may
need to change the Windows Explorer settings to find it.

Installing MultiTerm Desktop

Procedure
1. Go to My Account.
2. Select Products & Plans > Downloads ON the website.

3. Select Download next to MultiTerm 2022 Desktop Installer. Run the installer to unpack
the installation files and start the installation.

4. The MultiTerm Desktop Installer displays the End-User License Agreement. If you accept
the terms, select Next.

5. On the next screen, choose the components to install and select Next. When you select
the component, a description is displayed.
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@ Installing MultiTerm Desktop

6. Choose an installation location. We recommend that you install to the default location.
Avoid installing to the same directory used for any previous versions of MultiTerm. Select
Next.

7. Review your selection of components. Select Back to change any options. Select Next
to proceed with the installation.

The MultiTerm installer now installs the MultiTerm Desktop components.

If you are upgrading from a version of MultiTerm older than MultiTerm 2009, the old
termbases are moved to another folder, and a screen displays this fact. Select OK.

10. When the components are installed, the final screen is displayed. Select OK.

If you installed the MultiTerm Desktop Applications for Microsoft Word, the MultiTerm
tab is added to the Word ribbon the next time you run Word.

You can use the MultiTerm tab to access termbases and work with termbases data
from Word.

Installing and uninstalling silently

Preparing for silent installation - extract product
installers

Extract the installation files for the RWS products and the third-party software.

About this task

To do this, run the installer until the compressed files are all decompressed and extracted,
and then before the installation takes place, stop the installer. The package containing the
files is a self-extracting executable and can be decompressed with any decompressing utility
that works with the .rar compression format.

The unpack location is:

%ALLUSERSPROFILE%\Package Cache\Trados\MultiTermDesktop2022

About msiexec command-line options

Where the msiexec command is mentioned in the procedures described below, it is usually
with command line options such as /q or /1*x. You can use different options. For more
information about the command-line options for the msiexec command, see the website
msdn.microsoft.com .
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Installing the third-party software products

About this task
See also section Third-party software, above.

® Microsoft Windows Installer 3.1. This is not included in the Studio distribution package.
The command line to silently install is :

<path to package> /quiet /norestart /log:<path to log file>

® Microsoft .NET Framework version 4.8. You can find this on the Microsoft web site here .

® Microsoft Visual C++ 2008 Redistributable SP1 with MFC update Command line to silently
install:

"<Path to dir>\2008_SP1 vcredist x86.exe" /g

® Microsoft Visual C++ 2013 Redistributable with MFC update Command line to silently
install:

<Path to dir>\2013 vcredist x86.exe" /g /norestart /log "<path to log
file>"

This command may return an MSI error code if Visual C++ 2013 Redistributable is already
installed.

® Microsoft Web Services Enhancements 2.0 SP3

msiexec /i "<Path to dir>\Microsoft WSE 2.0 SP3 runtime.msi" /gn /l*v
"<path to log file>"

Installing MultiTerm components

About this task

Typically, a silent installation will run automatically. If not, manually install the .msi files
available in the following location: %ALLUSERSPROFILE%\Package Cache\Trados
\MultiTermDesktop2022\modules.

Procedure

1. Click start > Run and run the following command to install the two components
required for MultiTerm Desktop:

msiexec.exe /i "<path to MTStudiolé.msi file" /gn /l*v "<path to
log file>.

msiexec.exe /i "<path to MTCorelé6.msi" /gn /l*v "<path to
log files>.
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2. Runthe command again for any optional MultiTerm components that you require:
¢ MTConvert16.msi
¢ MTExtract16.msi
® MTWidget16.msi

Example set of commands to install a number
of RWS products

Command line properties used in the msiexec command.

INSTALLDIR. You can change the installation path for any of the RWS products by changing
the value of INSTALLDIR, but this is not recommended.

CLIENTINSTALL. Set this to 1 for the MT16Core.msi. If you set this to zero (0) the product will
have no start menu entry and no working autoupdate.

The commands

set INSTALL DIRECTORY=%ProgramFiles%\Trados\MultiTerm\MultiTerml?7

set LOG_DIRECTORY=%ALLUSERSPROFILE$%\Trados\Chainer\Logs

(For Windows 7 and Windows 8.1 and Windows 10)

set LOG DIRECTORY=%ALLUSERSPROFILE%\Application Data\Trados\Chainer\Logs

Uninstalling
To silently remove an MSI, use the following command:

msiexec /x "<path to msi file>"/gn

Note: Do not silently remove all msi modules that have been installed by the installer.
Otherwise you will not be able to use the Remove suite of products entry from the Control
Panel programs list.

12 Installation Guide



Installing MultiTerm Desktop @

Upgrading from previous MultiTerm
Installations

Overview of the Upgrade Process

Before you upgrade, take a copy of all termbases and termbase objects.

Install MultiTerm 2022 as described in Installing MultiTerm.

Software compatibility: previous versions

You can install MultiTerm 2022 alongside MultiTerm 2021 and run them simultaneously.

Note that you can install any version of MultiTerm Widget on the same computer. RWS
strongly recommends that you use the latest version.

MultiTerm Desktop can work with MultiTerm Server included with Trados GroupShare 2020
and Trados GroupShare 2017. Trados GroupShare 2015 is no longer supported.

Termbase and termbase object compatibility

Local termbases

MultiTerm 2007, MultiTerm 2009 and iX termbases are upgraded automatically when you
open them in MultiTerm 2022. MultiTerm 2011 and 2014, 2017, 2019 termbases can be used
without conversion.

However, you can continue to use older termbases in MultiTerm 2022. To do this, convert
them to MultiTerm XML format using MultiTerm Convert.

MultiTerm 2022 does not allow you to add terms which are longer than 1023 characters.
Terms imported from MultiTerm '95 or MultiTerm 5 which are longer than 1023 characters
may give faulty search results.

If you have a termbase created in MultiTerm version 5.5 or earlier, run MultiTerm Convert.
MultiTerm Convert produces a termbase definition (XDT) file, which describes the structure of
the terminology data. Use this XDT file to create an empty termbase, and import the
converted data into that termbase.
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Termbase objects

Termbase objects include filters, layouts, input models, export and import definitions.

Termbase objects cannot be migrated from MultiTerm '95 Plus or MultiTerm 5.x to MultiTerm
2022. After you have migrated the terminological data to MultiTerm 2022, create the
termbase objects manually.

File-based termbases created in MultiTerm 6.x to MultiTerm 2007 can be opened directly in
MultiTerm 2022 Desktop. Server-based termbases created in MultiTerm 6.x to MultiTerm
2007 have to be upgraded. The upgrade process is described in the Trados GroupShare
Installation Guide . For more information see the topic "Using SDL MultiTerm 2007
Termbases" in the MultiTerm 2022 Help .

To save termbase objects from later versions of MultiTerm, select Save (in the Catalog
view), and then load them into MultiTerm 2022.

Default locations for MultiTerm installations

The default installation locations for previous versions of MultiTerm are as follows.
MultiTerm Desktop version 17:
%ProgramFiles%\Trados\MultiTerm\MultiTerml?7
MultiTerm Desktop version 16:
%ProgramFiles%\SDL\SDL MultiTerm\MultiTermlé6
MultiTerm Desktop version 15:
%ProgramFiles%\SDL\SDL MultiTerm\MultiTerml5
MultiTerm Desktop version 14:
%ProgramFiles%\SDL\SDL MultiTerm\MultiTerml4
MultiTerm Desktop version 12:
%ProgramFiles%\SDL\SDL MultiTerm\MultiTerml2
MultiTerm Desktop version 11:
%ProgramFiles%\SDL\SDL MultiTerm\MultiTermll
MultiTerm Desktop version 9:
%ProgramFiles%\SDL\SDL MultiTerm\MultiTerm9
MultiTerm Desktop version 8:
%ProgramFiles%\SDL\SDL MultiTerm\8

MultiTerm Desktop version 7.5:

%ProgramFiles%\SDL International\SDL MultiTerm 2007
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MultiTerm Desktop version 7.0 and 7.1:
%ProgramFiles%\TRADOS\\

MultiTerm Workstation version 6.2:
%ProgramFiles%\TRADOS\MTiX\\
MultiTerm Workstation version 6.0:

%ProgramFiles%\TRADOS\Corporate Language\\

Uninstalling MultiTerm

Uninstalling MultiTerm Desktop removes all the MultiTerm program files, folders and registry
entries but retains all the data files and folders, including the termbase files, associated
termbase data, and saved object definitions.

Procedure

1. You uninstall via start > Control Panel > Programs > Uninstall @ program or
Programs and Features. Choose Uninstall or Remove, as appropriate.

Select MultiTerm 2022 - Remove suite of products.
Select the components you want to uninstall and select Next.
An information box is displayed. It is updated automatically as the removal proceeds.

vk WwN

When the selected components have been removed, a confirmation dialog box is
displayed.

6. Select OK.

Software updates

Temporary directory

Software updates are downloaded to the following temporary directory:
%temp%\multiterml7Updates

After the update is installed, you can delete this directory.
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Software update log files

MultiTerm Desktop creates a file that logs the checking for updates and the downloading of
the installer for the update. This log file is in:

%ALLUSERSPROFILE%\Trados\MultiTerm\MultiTerml7\Updates
Another log file is created during the update. You can find it in:

%temp%\multiterml7Updates

Individual user software updates

By default, as a MultiTerm user, you can do the following:

Procedure

1. Specify that MultiTerm Desktop checks for software updates when it starts. To do this,
select File > Options > Automatic Updates.

Manually check for updates. To do this, select Help > Check for Updates.
Check for updates via Start > MultiTerm 2022 > Check for updates

The system administrator can enable or disable checking for software updates, so these
options may not always be available.

Change the notification policy for updates

By default, MultiTerm Desktop notifies users when a software update is available, and also
gives users the option to install updates. As an administrator, you can change these settings.

About this task
To change these options, define a group policy, as follows:

Procedure
1. Select start > Run and enter the command: gpedit .msc
The Group Policy dialog box is displayed.

2. Right-C”Ck Computer Configuration > Administrative Templates and select
Add/Remove Templates from the shortcut menu.

The Add/Remove Templates dialog box is displayed.

3. Select Add and browse to the MultiTermAutoUpdate. adm file.
The default location for this file is:
%ALLUSERSPROFILE%\Package Cache\Trados\MultiTermDesktop2022

4. C(Classic Administrative Templates (ADM) > SDL Applications > SDL MultiTerm vl iS
added to the navigation tree. Select this to display its settings on the right.

Double-click Enable Auto-update.

The Enable Autoupdate Properties dialog box is displayed on the Setting tab. Choose
one of the following options and select OK.
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® Not Configured - The user can choose to enable or disable automatic checking for
application updates and can also manually check for application updates.

® Enabled - MultiTerm Desktop checks for updates automatically. The user cannot
disable the automatic updates option. The user can also manually check for
application updates.

® Disabled - Automatic and manual checks for updates are both disabled. The user
cannot enable these options.

Remove your software update

Procedure
1. Inthe Windows Control Panel, select Add or Remove Programs or Programs and
Features.

To see the software updates, select View Installed Updates.
Select the software update and select Remove/ Uninstall.

Follow the on screen instructions.
If you don't want to automatically check for updates, clear the check box Automatically
check for updates when the application starts under Options > Automatic Updates.

Digital certificate requirements

All MultiTerm Desktop code and installer files are digitally signed. Make sure your list of
approved root certificates is up-to-date and includes the root certificate from the Certification
Authority that generates MultiTerm Desktop's code signing certificate. At the time of writing,
Trados Studio require DigiCert Assured ID Root CA and DigiCert Assured ID Code Signing

CA-1.

® For computers with access to the Internet, go to https://www.digicert.com and add the
new root certificate to your Trusted Root Certification Authorities certificate store. This
is only available for computers running on operating systems supported by Microsoft
(Windows Vista or later).

® For computers in a locked down corporate environment without access to the Internet,
follow the instructions available at https://technet.microsoft.com/library/dn265983.aspx .

You can also download the specific root certificates directly from
https://www.digicert.com/digicert-root-certificates.htm and apply the certificates to each
locked down workstation manually or by group policy.

Installation Guide 17


https://www.digicert.com/
https://technet.microsoft.com/library/dn265983.aspx
https://www.digicert.com/digicert-root-certificates.htm

@ Installing MultiTerm Desktop

18 Installation Guide



©

Acknowledgments




@ Acknowledgments

MultiTerm includes open source or similar third-party software.

Crc32C.NET.signed
Version: 1.0.5

Vendor: Robert Vazan
Copyright: Copyright (c) 2014-2020, Robert Vazan
License type: BSD-3-Clause

License details: https://github.com/robertvazan/crc32c.net/blob/master/LICENSE

Microsoft.ApplicationInsights
Version: 2.12.1

Vendor: Microsoft
Copyright: Copyright (c) 2015 Microsoft
License type: MIT

License details: https://github.com/microsoft/ApplicationInsights-dotnet/blob/2.12.
1/LICENSE

CommandLineParser
Version: 1.9.71

Vendor: Giacomo Stelluti Scala
Copyright: Copyright (c) 2005 - 2013 Giacomo Stelluti Scala
License type: MIT

License details: https://github.com/commandlineparser/commandline/blob/v1.9.71.
2/doc/LICENSE

Microsoft.AspNet.WebApi.Client
Version: 5.2.7

Vendor: Microsoft
Copyright: © Microsoft Corporation. All rights reserved.
License type: Apache 2.0

License details: https://github.com/aspnet/AspNetWebStack/blob/v3.2.7/LICENSE.txt

Microsoft.AspNetCore.SignalR.Client
Version: 1.1.0

Vendor: Microsoft

Copyright: Copyright (c) .NET Foundation and Contributors
License type: Apache 2.0

License details: https://github.com/aspnet/SignalR/blob/1.1.0/LICENSE.txt

20 Installation Guide


https://github.com/robertvazan/crc32c.net/blob/master/LICENSE
https://github.com/microsoft/ApplicationInsights-dotnet/blob/2.12.1/LICENSE
https://github.com/microsoft/ApplicationInsights-dotnet/blob/2.12.1/LICENSE
https://github.com/commandlineparser/commandline/blob/v1.9.71.2/doc/LICENSE
https://github.com/commandlineparser/commandline/blob/v1.9.71.2/doc/LICENSE
https://github.com/aspnet/AspNetWebStack/blob/v3.2.7/LICENSE.txt
https://github.com/aspnet/SignalR/blob/1.1.0/LICENSE.txt

Acknowledgments @

Microsoft.IdentityModel.Protocol.Extensions
Version: 1.0.4.403061554

Vendor: Microsoft
Copyright: Copyright (c) Microsoft Corporation
License type: MIT

License details: https://github.com/AzureAD/azure-activedirectory-identitymodel
-extensions-for-dotnet/blob/dev/LICENSE.txt

System.IdentityModel.Tokens.Jwt
Version: 6.11.1.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.
License type: MIT

License details: https://github.com/AzureAD/azure-activedirectory-identitymodel
-extensions-for-dotnet/blob/dev/LICENSE.txt

Microsoft.IdentityModel.Tokens
Version: 6.11.1.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.
License type: MIT

License details: https://github.com/AzureAD/azure-activedirectory-identitymodel
-extensions-for-dotnet/blob/6.7.1/LICENSE.txt

YamlIDotNet
Version: 8.1.1.0

Vendor: Antoine Aubry
Copyright: Copyright (c) Antoine Aubry and contributors 2008 - 2019
License type: MIT

License details: https://github.com/aaubry/YamIDotNet/blob/v8.1.2/LICENSE.txt

NETStandard.Library
Version: 2.0.3

Vendor: Microsoft

Copyright: Copyright (c) .NET Foundation and Contributors
License type: MIT

License details: https://github.com/dotnet/standard/blob/v2.0.3/LICENSE.TXT
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Autofac
Version: 4.8.1

Vendor: Autofac
Copyright: Copyright © 2015 Autofac Contributors
License type: MIT

License details: https://github.com/autofac/Autofac/blob/v4.8.1/LICENSE

HtmlAgilityPack
Version: 1.11.34.0

Vendor: ZZZ Projects
Copyright: Copyright © ZZZ Projects Inc.
License type: MIT

License details: https://github.com/zzzprojects/html-agility-pack/blob/v1.11.16/LICENSE

Xliff.OM
Version: 1.0.2

Vendor: RyanKi
Copyright: Copyright 2016 RyanKi
License type: MIT

License details: https://github.com/microsoft/XLIFF2-Object
-Model/blob/master/LICENSE.txt

murmurhash-signed
Version: 1.0.3.0

Vendor: Darren Kopp
Copyright: Copyright 2013 Darren Kopp
License type: Apache 2.0

License details: https://github.com/darrenkopp/murmurhash
-net/blob/master/LICENSE.md

System.IO.Abstractions
Version: 13.2.38.0

Vendor: Tatham Oddie
Copyright: Copyright © Tatham Oddie 2010
License type: MIT

License details: https://github.com/System-10-Abstractions/System.I0.Abstractions/blob/v
4.2.17/LICENSE
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Flee
Version: 1.2.2

Vendor: Muhammet Parlak
Copyright: Copyright 2017 Muhammet Parlak
License type: L-GPL

License details: https://github.com/mparlak/Flee

PowerCollections
Version: 1.0.0.0

Vendor: Wintellect
Copyright: Copyright 2015 Wintellect
License type: EPL

License details: https://www.nuget.org/packages/Stakata.Wintellect.PowerCollections/1.0.
4/License

ANTLR 3 Runtime
Version: 3.1.3

Vendor: Terence Parr

Copyright: Copyright (c) 2011 The ANTLR Project
License type: BSD

License details: https://github.com/antlr/antlrcs/blob/master/LICENSE.txt

CachedImage
Version: 0.1.8

Vendor: Haridas Pachuveetil
Copyright: Copyright (c) 2014 Haridas Pachuveetil
License type: MIT

License details: https://github.com/floydpink/CachedImage/blob/main/LICENSE

Microsoft.AspNetCore.JsonPatch
Version: 5.0.7

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.
License type: Apache 2.0

License details: https://github.com/dotnet/aspnetcore/blob/1.1.1/LICENSE.txt

Microsoft.Extensions.Dependencylnjection.Abstractions
Version: 5.0.0.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.
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License type: MIT

License details: https://github.com/dotnet/extensions/blob/9bc79b2f25a3724376d7af
19617c33749a30ea3a/LICENSE.txt

Microsoft.Extensions.DependencyModel
Version: 2.0.4

Vendor: Microsoft
Copyright: Copyright (c) .NET Foundation and Contributors
License type: MIT

License details: https://github.com/dotnet/core-setup/blob/v2.0.4/LICENSE.TXT

Microsoft.IdentityModel.JsonWebTokens
Version: 6.11.0.0

Vendor: Microsoft
Copyright: Copyright (c) .NET Foundation and Contributors
License type: MIT

License details: https://github.com/AzureAD/azure-activedirectory-identitymodel
-extensions-for-dotnet/blob/5.6.0/LICENSE.txt

Microsoft.IdentityModel.Logging
Version: 6.11.1.0

Vendor: Microsoft
Copyright: Copyright (c) .NET Foundation and Contributors
License type: MIT

License details: https://github.com/AzureAD/azure-activedirectory-identitymodel
-extensions-for-dotnet/blob/5.6.0/LICENSE.txt

log4net
Version: 2.0.8

Vendor: The Apache Software Foundation
Copyright: Copyright 2004-2017 The Apache Software Foundation
License type: Apache 2.0

License details: https://github.com/apache/logging-log4net/blob/rel/2.0.8/LICENSE

Markdig.Signed
Version: 0.18.3

Vendor: Alexandre Mutel

Copyright: Copyright (c) 2018-2019, Alexandre Mutel

License type: BSD-2-Clause

License details: https://github.com/xoofx/markdig/blob/0.18.3/license.txt
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NLog
Version: 4.6.7

Vendor: Jarek Kowalski, Kim Christensen, Julian Verdurmen
Copyright: Copyright (c) 2004-2020 NLog Project - https://nlog-project.org/
License type: BSD-3-Clause

License details: https://github.com/NLog/NLog/blob/v4.6.7/LICENSE.txt

SharpZipLib
Version: 1.2.0

Vendor: ICSharpCode
Copyright: Copyright © 2000-2018 SharpZipLib Contributors
License type: MIT

License details: https://github.com/icsharpcode/SharpZipLib/blob/v1.2.0/LICENSE.txt

System.Data.SQLite
Version: 1.0.111.0

Vendor: SQLite

Copyright: Public domain

License type: Public domain

License details: https://www.sglite.org/copyright.html

ICU
Version: 59.1.15.0

Vendor: SIL International

Copyright: Copyright (c) 2016-2017 SIL International
License type: ICU

License details: https://github.com/unicode-org/icu/blob/release-59-1/icu4c/LICENSE

DocumentFormat.OpenXml
Version: 2.8.1

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/OfficeDev/Open-XML/blob/v2.8.1/LICENSE

System.ValueTuple
Version: 4.5.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.
License type: MIT
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License details: https://github.com/dotnet/corefx/blob/master/LICENSE.TXT

System.Collections.Immutable
Version: 5.0.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/runtime/blob/v5.0.0/LICENSE.TXT

System.Reactive
Version: 4.3.2

Vendor: .NET Foundation and Contributors

Copyright: Copyright (c) .NET Foundation and Contributors.
License type: MIT

License details: https://github.com/dotnet/reactive/blob/rxnet-v4.3.2/LICENSE

Newtonsoft.Json
Version: 12.0.2

Vendor: James Newton-King

Copyright: Copyright © James Newton-King 2008

License type: MIT

License details: https://github.com/JamesNK/Newtonsoft.Json/blob/12.0.2/LICENSE.md

SmartThreadPool
Version: 2.2.6.0

Vendor: Ami Bar

Copyright: Copyright © Ami Bar

License type: MS-PL

License details: https://github.com/amibar/SmartThreadPool/blob/v2.2.6/LICENSE

Simplelnjector
Version: 5.3.0.0

Vendor: Simple Injector Contributors

Copyright: Simple Injector Contributors 2010 - 2020

License type: MIT

License details: https://github.com/simpleinjector/Simplelnjector/blob/v4.9/LICENSE

Microsoft.Xaml.Behaviors.Wpf
Version: 1.1.19.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.
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License type: MIT

License details: https://github.com/microsoft/XamIBehaviorsWpf/blob/v1.1.19/LICENSE

Microsoft.Extensions.Logging.Abstractions
Version: 5.0.0.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.
License type: MIT

License details: https://github.com/dotnet/extensions/blob/2.2.0/LICENSE.txt

MaterialDesignThemes.MahApps
Version: 0.0.11

Vendor: James Willock
Copyright: Copyright 2015 James Willock/Mulholland Software Ltd
License type: MS-PL

License details: https://www.nuget.org/packages/MaterialDesignThemes.MahApps/0.0.11

OpenXmlPowerTools
Version: 4.5.3.0

Vendor: Eric White
Copyright: Copyright © Eric White
License type: MIT

License details: https://github.com/OfficeDev/Open-Xml-PowerTools/blob/vNext/LICENSE

WatiN
Version: 2.1.0.0

Vendor: Jeroen van Menen

Copyright: Copyright © Jeroen van Menen
License type: Apache 2.0

License details: https://www.nuget.org/packages/WatiN/2.1.0

System.Threading.Tasks.Extensions
Version: 4.5.4.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.
License type: MIT

License details: https://github.com/dotnet/corefx/blob/master/LICENSE.TXT
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System.Security.Cryptography.X509Certificate
Version: 4.3.2.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/corefx/blob/master/LICENSE.TXT

System.Security.Cryptography.Algorithms
Version: 4.3.1.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/corefx/blob/master/LICENSE.TXT

System.Reflection.TypeExtensions
Version: 4.7.0.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/corefx/blob/master/LICENSE.TXT

System.Linq.Queryable
Version: 4.3.0.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/corefx/blob/master/LICENSE.TXT

System.IO.FileSystem.Primitives
Version: 4.3.0.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/corefx/blob/master/LICENSE.TXT

System.Memory
Version: 4.5.4.0

Vendor: Microsoft
Copyright: © Microsoft Corporation. All rights reserved.
License type: MIT
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License details: https://github.com/dotnet/corefx/blob/master/LICENSE.TXT

System.Numerics.Vectors
Version: 4.5.0.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/corefx/blob/master/LICENSE.TXT

System.Buffers
Version: 4.5.1.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/corefx/blob/master/LICENSE.TXT

System.Runtime.CompilerServices.Unsafe
Version: 5.0.0.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/corefx/blob/master/LICENSE.TXT

SharpCompress
Version: 0.26.0

Vendor: Adam Hathcock
Copyright: Adam Hathcock
License type: MIT

License details: https://github.com/adamhathcock/sharpcompress/blob/0.26/LICENSE.txt

Sdl.MultiSelectCombobox
Version: 1.0.17

Vendor: RWS
Copyright: Copyright © RWS
License type: Apache 2.0

License details: https://github.com/sdl/Multiselect-ComboBox/blob/master/LICENSE

Microsoft.WindowsAPICodePack.Shell
Version: 1.1.0.0

Vendor: Nanalich

Copyright:
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License type:
License details:

icu.net
Version: 2.7.1.0

Vendor: SIL International

Copyright: Copyright © 2007-2019 SIL International
License type: MIT

License details: https://github.com/sillsdev/icu-dotnet/blob/v2.5.4/LICENSE

Microsoft.Extensions.Http
Version: 5.0.0.0

Vendor: Microsoft
Copyright: © Microsoft Corporation. All rights reserved.
License type: Apache 2.0

License details: https://github.com/aspnet/HttpClientFactory/blob/2.2.0/LICENSE.txt

MahApps.Metro
Version: 1.5.0

Vendor: Jan Karger, Dennis Daume, Brendan Forster, Paul Jenkins, Jake Ginnivan, Alex
Mitchell

Copyright: Copyright © 2021 .NET Foundation and Contributors. All rights reserved.
License type: MIT

License details: https://github.com/MahApps/MahApps.Metro/blob/1.5.0/LICENSE

NQuant
Version: 1.0.3

Vendor: Matt Wrock
Copyright: Copyright Matt Wrock 2011
License type: Apache 2.0

License details: https://github.com/philjones/nquant/blob/master/License.txt
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